
SpeedType Compatibility Issues 
 
This document discusses solutions to problems using SpeedType on popular word 
processing and transcription platforms.  You should read the “Debugging SpeedType” 
section first.  If you have questions, you can contact us through 
http://SpeedType.com/contact.html?? 
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Recommend SpeedType Setting  

This is the recommended SpeedType setting for most word processors: 
 

1. Bring up SpeedType's Main Window by pressing F10 in your word processor or by 
clicking the SpeedType icon in the system tray. 



2. Choose Preferences from SpeedType's File menu. 
3. Set the Pause setting to:  "Pause 20 msec after every 1 keystrokes" 
4. Make sure the "VERIFY TARGET WINDOW RECEIVES KEYSTROKES" box is 

CHECKED. 
5. Select (check) the "Simulate Clipboard Paste if Text Only" box. 
6. Click OK to save your changes. 
7. Click the HIDE button. 

 
NOTE: 
Microsoft Word, by default, automatically adds extra spaces if you select the "Simulate 
Clipboard Paste if Text Only" as the SpeedType text transfer method. 
 
To disable the automatic spaces in Word 2010 and later: 

1. In MS Word, click the File tab (found at the top left corner of your MS Word window) and 
then click Options on the bottom of the File Options pane. 

2. On the left pane, select Advanced. 
3. Under the "Cut, copy and paste" section, uncheck the 

   "Use smart cut and paste" box. 
 
To disable the automatic spaces in Word 2007: 

1. Click the Office button (the large round button on the upper left corner) 
2. Click Word Options (at the bottom of the menu). 
3. On the left pane, select Advanced. 
4. Under the "Cut, copy and paste" section, uncheck the "Use smart cut and paste" box. 

 
For older versions of Word: 

1. From Word's Tools menu, click Options then click the Edit tab. 
2. Uncheck the "Smart cut and paste" box. 

 
 
-- Use SHIFT instead of CAPS LOCK to capitalize expansions 
 
If you had set your SpeedType text transfer method 
to "Simulate Clipboard Paste", the CAPS LOCK key will have no effect 
on the expanded text (this is because CAPS LOCK has no effect on 
the text copied through the clipboard). 
 
Instead of using CAPS LOCK to capitalize words, 
we suggest you use one of these techniques to capitalize 
an expansion: 
 
 
 
 



Simply type the abbreviation in all CAPS using the SHIFT key. 
For example, if you have the following abbreviation: 
 
 subj = subjective 
 
typing "SUBJ"<SPACE> will expand to "SUBJECTIVE". 
(note: use your SHIFT key to type "SUBJ"). 
 
Another technique is to define separate abbreviations for 
your long forms that you need in all CAPS. 
 
for example: 
 
subj = subjective 
subj1 = SUBJECTIVE 
 

Debugging SpeedType 

If you have problems getting SpeedType to work, try testing SpeedType with the Windows 
Notepad: 
 

1. Restart your computer (this is important to make sure all errors are cleared) 
2. Start SpeedType. See the “Windows Compatibility Mode” section below if you get 

message: "Allow st10 to make changes to my computer?" when you launch 
SpeedType (SpeedType usually won't work if you are seeing that message). 

3. Choose Preferences from SpeedType's File menu. 
4. Select the "4. AutoReplace" tab. 
5. Select the "Show Suggestion Window" check box. 
6. Click OK. You should now see the yellow Suggestion Window (which you can move and 

resize) on your screen. 
7. Click the HIDE button to make the SpeedType Main Window disappear. 
8. Launch the Windows NOTEPAD by pressing Win+R (while holding down the Windows 

Logo key, press R.  The Windows Logo key is normally between the Ctrl and Alt keys on 
the left side of your keyboard).   

9. In the OPEN box, type:   notepad    then press ENTER 
10. In the Notepad window, type "asap".   Does "asap" show up in SpeedType's Suggestion 

Window? 
 
Whenever you type something, you should observe your most recent word displayed in the 
Suggestion Window. This should help you see if SpeedType is working or not. For example, if 
you type "asap" in your word processor, you should see "asap" in the Suggestion Window. 
If you see only "sap", this means SpeedType failed to receive the first character. If you see 
nothing at all in the Suggestion Window, this means SpeedType could not track the keystrokes 
in the word processor (see the rest of this document for suggestions on how to get SpeedType 



to work in your word processor). 

Windows Compatibility Mode 

SpeedType usually will NOT work if you get message: "Allow st10 to make changes to my 
computer?" when you launch SpeedType. You should make sure you are NOT running 
SpeedType in Windows Compatibility mode: 
 

1. Shut down and restart Windows. 
2. Right-click on the SpeedType desktop icon that you use to launch SpeedType then 

select Properties. The "SpeedType 10 Properties" window should appear. 
3. Select the Compatibility tab. 
4. Make sure the ALL the following 5 boxes are NOT checked: 

a. Run this program in compatibility mode 
b. Run in 256 colors. 
c. Run in 640 X 480 screen resolution. 
d. Disable visual themes. 
e. Run this program as an administrator 

5. Click the OK button to close "SpeedType 10 Properties" window. 
6. Start SpeedType by double-clicking on the SpeedType desktop icon. 

 

Running SpeedType as Administrator 

If SpeedType still does not work, try running SpeedType as "administrator": 
1. Shut down SpeedType (choose EXIT from SpeedType's FILE menu). 
2. Right-click the SpeedType 10 icon that you use to start SpeedType, and then click Run 

as administrator from the menu.  
NOTE:  You should NEVER select "Run this program as an administrator" box in the 
Windows Compatibility window. 
 
This is the correct procedure to run SpeedType as "administrator": 

1. Shut down SpeedType (choose EXIT from SpeedType's FILE menu). 
2. Right-click the SpeedType 10 icon that you use to start SpeedType, and then click Run 

as administrator from the menu. 
 
You usually need to run SpeedType as administrator only if your word processor is 
running as administrator. 
 

If ComCast is your Internet Provider 

If you use ComCast as your Internet Provider: check if there is program called "Constant Guard" 
running on your computer. SpeedType is not compatible with Constant Guard which contains a 
keyboard logger. Constant Guard is a free program that is automatically installed 
on your computer if you are using Comcast as your internet provider. 



 
You may want to try uninstalling Constant Guard to see if that is causing the 
SpeedType problem (you need to restart Windows after uninstalling Constant Guard to make 
sure it really is disabled before trying out SpeedType). 

BayScribe 

See Internet Explorer Vertical Lines 

ChartNet 

If SpeedType does not work in ChartNet, try restarting SpeedType: 
● Shut down SpeedType (choose Exit from SpeedType's File menu) then launch 

SpeedType. 
● Some users report that you need to restart SpeedType every time after opening a new 

ChartNet report. To avoid having to restart SpeedType all the time, disable the ChartNet 
expander. 

 
This is the suggested SpeedType setting for ChartNet: 
1. From SpeedType's File menu, choose Preferences. 
2. Select the "4. AutoReplace" tab. 
3. Unselect (uncheck) the "Enable Automatic Keyword Completion" box. 
4. Unselect (uncheck) the "Remember Last Expanded Word" box. 
5. Click OK to save your changes. 
6. Click the HIDE button. 
 

Chrome 

Chrome has a security feature which sometimes blocks the ENTER key if Chrome detects a 
program (like SpeedType) is tracking your keystrokes. 
 
Here's how to get around the problem: 
 
You can create a SpeedType macro to simulate the ENTER key with another key press. 
 
Here's a SpeedType entry that will make pressing Enter (or any other keyboard combination 
you want) to simulate the ENTER key: 
 
Press F10 to bring up SpeedType. Then choose ADD from SpeedType's DICTIONARY menu to 
create the following entry: 
 
KEYWORD: enter2 (or any abbreviation you want) 

SHORTCUT: Enter 
TEXT TO TYPE: {@KEY Enter} 
 



 
Notes: 
 
1. To create the SHORTCUT for Enter: 
 Click the SHORTCUT button. 
 When the Next Key Typed window appears, press ENTER. 
  
2.  Type "{@KEY Enter}" in the TEXT TO TYPE box exactly as you see it 

(exactly 12 characters; be careful not to press ENTER in the TEXT TO TYPE 
box).  
 
Now whenever you press the ENTER key, SpeedType simulate the ENTER key. 
 
This appears to bypass Chrome's security feature however pressing ENTER will 
no longer expand abbreviations, i.e., if you type an abbreviation followed by ENTER, it will 
not be expanded (you can press SPACE, TAB, or a period after the abbreviation to expand the 
abbreviation). 
 

Citrix Terminal Server 

Many SpeedType users have been using SpeedType with Citrix with no problems; here is what 
they told us (in their own words): 
 
"To use SpeedType with a word processor on Citrix, you have to push out a Desktop session to 
the end users. You CANNOT use the Published Applications session because, if you do this, 
SpeedType and your word processor will be on two separate sessions and SpeedType 
therefore cannot communicate with the word processor on the other session. When you push 
the Desktop session to the end user, you are giving them a single session to run all their 
applications they need." 
 
What you need to do is install SpeedType on the Citrix server so both SpeedType and Citrix 
apps can run on the same session. 
 
Another user has a different solution: 
Install SpeedType on your local PC and run your Citrix session in a window and not full screen. 
SpeedType will work as long as you don't make your Citrix session as full screen. 

Dictaphone EXText 

From feedback received from many SpeedType users, SpeedType can work with EXText if you 
first disable the word expander that comes with EXText. Please consult your EXText 
documentation for instructions on how to disable the word expander that comes with EXText. 
If SpeedType still does not work after disabling the word expander that comes with EXText, 
here are a couple of things to try: 



 
If your EXText is running inside the Internet Explorer web browser AND you have Windows 
Vista or Windows 7 you should disable IE's "protected mode": 

1. Under IE's TOOLS menu, select INTERNET OPTIONS followed by the SECURITY tab. 
2. Then uncheck the "Enable Protected Mode" box. 
3. Note that you need to restart IE after you make this change. 

 
Also see: Running SpeedType as "administrator". 
 

DocQScribe 

We have received feedback from many users who say they have been using SpeedType with 
DocQScribe for several years with no problems. It's possible there are variable DocQScribe 
platforms and SpeedType may not work with certain DocQScribe platforms.  The main thing to 
watch out for is to make sure you don't have two expanders running at the same time (i.e. if 
DocQScribe comes with an expander, make sure you turn off the DocQScribe expander). 
 

eScription EditScript 

This is the recommended SpeedType setting for EditScript: 
 

1. In SpeedType, choose Preferences from the File menu. 
2. Check "Verify target window receives keystrokes." 
3. Change the "Pause" right above that to "Pause 100 msec after every 1 keystroke." 
4. Select (check) the "Simulate Clipboard Paste if Text Only" box. 
5. Click OK to save your changes. 
6. Click the HIDE button to activate SpeedType. 

 
Microsoft Word, by default, automatically adds an extra space after the first character of 
expansions if you select the "Simulate Clipboard Paste if Text Only" as the SpeedType text 
transfer method.  
 
To disable the automatic spaces in Word 2010: 

1. In MS Word, click the File tab (found at the top left corner of your MS Word window) and 
then click Options on the bottom of the File Options pane. 

2. On the left pane, select Advanced. 
3. Under the "Cut, copy and paste" section, uncheck the "Use smart cut and paste" box. 

 
To disable the automatic spaces in Word 2007: 
 

1. Click the Office button (the large round button on the upper left corner) 
2. Click Word Options (at the bottom of the menu). 
3. On the left pane, select Advanced. 



4. Under the "Cut, copy and paste" section, uncheck the “Use smart cut and paste" box. 
 
For older versions of Word: 

1. From Word's Tools menu, click Options then click the Edit tab. 
2. Uncheck the "Smart cut and paste" box. 

 

EMDAT 

A SpeedType user informed us that Inscribe EMDAT has a word expander which can interfere 
with SpeedType and cause SpeedType not being able to track BACKSPACEs; you should 
disable the built-in expander in Inscribe EMDAT. 
 
Another SpeedType user told us the following SpeedType setting may also fix the BACKSPACE 
problem: 
 

1. Choose Preferences from SpeedType's FILE menu and set the Pause setting to "Pause 
0 msec every 1 keystrokes". 

2. UNCHECK the "Verify target window receives keystrokes" box.    
 
Please note that the above setting will cause SpeedType to expand at full speed and may cause 
problems using SpeedType with other word processors. 

GEMMS 

Below is a tip we got from a SpeedType user (the solution is to reduce the size of your GEMMS 
application window so it is not occupying your full screen): 
 
"There is a little tool bar at the top of the screen, in the center, when you first log in to GEMMS. 
This is the tool bar I was using to minimize the client's desktop so I could see my own. Click on 
the 2 boxes next to the minimize ("-") to reduce to a window. After that, SpeedType was able to 
work correctly." 

Internet Explorer  

Internet Explorer has "protected mode" enabled which prevents SpeedType from tracking your 
keystrokes while typing in an Internet Explorer window. 
 
How to make SpeedType work with ALL web pages: 
 

1. Open Internet Explorer. 
2. Click the TOOLS menu (the “gear” icon on the upper right corner) and select INTERNET 

OPTIONS. 
3. Click the SECURITY tab. 
4. Unselect (uncheck) the "Enable Protected Mode" box. 
5. You will need to restart Internet Explorer for the settings to take effect. 



 
Running IE with protected mode disabled may display a message stating that "your computer 
may be at risk".  As long as you don't visit any questionable web sites you should be ok.  
Another option would be to use the free FireFox web browser (http://www.firefox.com) 
which is much faster and more secure than IE and works much better with SpeedType. 

Internet Explorer Vertical Lines 

 
This fix requires SpeedType v10.1b or later (choose ABOUT from SpeedType’s HELP menu to 
see what version of SpeedType you have). 
 

1. Press F10 to bring up SpeedType, shut it down (choose EXIT from SpeedType's FILE 
menu). 

2. Choose Preferences from SpeedType's File menu. 
3. Select the "4. AutoReplace" tab. 
4.  Unselect (UNCHECK):   Support Different User Context    
5. Click the HIDE button to make the SpeedType Main Window disappear. 

 
NOTES: 
This fixes the vertical line and track cursor problems in IE but a side-effect is that SpeedType 
may no longer work correctly with applications running under a different user context (but this 
usually can be fixed by running SpeedType as administrator). 
 
MDinTouch InScribe and TouchType 2 
If MDinTouch comes with its own word expander (not SpeedType), please disable the 
MDinTouch expander. 
 
Also see: Running SpeedType as "administrator". 

Meditech 

You usually can "paste" text from the clipboard into Meditech using the ALT+V keyboard 
command. If so, you may want to try using SpeedType's "Simulate Clipboard Paste" to reliably 
expand text using a clipboard transfer instead of simulating each keystroke: 
 

1. Bring up SpeedType's Main Window by pressing F10 in your word processor or by 
clicking the SpeedType icon in the system tray. 

2. Choose Preferences from SpeedType's File menu. 
3. Click on the PASTE KEY button and press Alt+V.   (This assumes that Meditech's 

keyboard command to paste from the clipboard is "Alt+V"; if your Meditech has a 
different clipboard paste command, please let us know.)  NOTE: Meditech is the only 
program we are aware of that uses Alt+V as the clipboard Paste command, other 
programs (e.g. Word) uses Shift+Ins as the paste command so SpeedType will no 
longer be able to expand in programs such as Word after you set the PASTE key to 



Alt+V. 
4. Set the Pause to "Pause 50 msec every 1 keystrokes" (this tells SpeedType to wait 50 

milliseconds) after every 1 keystroke simulated by SpeedType). 
5. Select (check) the "Simulate Clipboard Paste if Text Only" box. 
6. Click OK to save your settings. 
7. Click the HIDE button to hide SpeedType. 

 
Now, whenever you type a SpeedType abbreviation, SpeedType first simulates backspaces to 
delete the abbreviation followed by an Alt+V to simulate the clipboard paste command to paste 
your long form. 
 
Another suggestion: 
One SpeedType user informed us she doesn't type direct into Meditech (Meditech was just too 
slow); instead she types her reports in WordPad then transfers (copy and paste) the final report 
to Meditech. If you want to use SpeedType in WordPad, this is the recommended SpeedType 
setting for WordPad: 
 

1. Choose Preferences from SpeedType's File menu and set the following: 
2. Click the PASTE KEY button then press Shift+Ins 
3. Set the pause to: PAUSE 20 msec every 1 keystrokes 
4. Make sure the VERIFY TARGET WINDOW RECEIVES KEYSTROKES option is 

CHECKED  
5. Make sure the SIMULATE CLIPBOARD PASTE IF TEXT ONLY is CHECKED. 

Medrite-XL 

A SpeedType user has informed us that she was able to make SpeedType work 
with Medrite XL by disabling the Medrite glossary. 
 

1. This applies to Digiscribe-XL version 3.3. This is Medrite-XL for Windows - NOT for 
DOS. 

2. An administrator on the system needs to launch the Medrite-XL Console program. 
3. Click on Profiles/Transcriptionist. 
4. Then select the transcriptionist in question. (Make sure the MT in question is currently 

not running the transcription program) 
5. In the MT's profile window, click on the "Personal Info" tab. 
6. In the upper right of that window, there is a section with a box around it called, "Chars to 

expand glossary"  
7. You have a choice of "No Glossary", "1 char" or "2 chars". 
8. Select "No Glossary". 
9. Then click on the "Update" button near the lower right of this window to apply the 

change. 
 



Microsoft Edge Browser 

it appears Microsoft Edge does not have an option to turn off protected mode so SpeedType 
cannot track your keystrokes in Microsoft Edge. The work around is to use another browser 
such as Internet Explorer, Firefox or Google Chrome. 
 
NOTE: Internet Explorer is still available in Windows 10: 

1. Press the Windows key. 
2. Type "Internet Explorer". 
3. Right click on "Internet Explorer" 
4. Click on "Pin to taskbar" to put it on your taskbar. 

 
Internet Explorer, by default, has "protected mode" enabled which 
prevents SpeedType from tracking your keystrokes while 
typing in an Internet Explorer window. 
 
How to make SpeedType work with ALL web pages: 
1. Open Internet Explorer. 
2. Click the TOOLS menu (the gear icon on the upper right corner) and select INTERNET 
OPTIONS. 
3. Click the SECURITY tab. 
4. Unselect (uncheck) the "Enable Protected Mode" box. 
5. You will need to restart Internet Explorer for the settings to 
  take effect. 

Microsoft Excel 

SpeedType may not always expand an abbreviation in some applications (notably Microsoft 
Excel) if the abbreviation was the FIRST word you type in the window. The reason is that Excel 
creates and switches to an invisible window right after you type the first character and, for safety 
reasons, SpeedType automatically resets its internal buffers whenever you change a window. If 
you need to type an abbreviation as the first word in a cell, the workaround is to either type a 
SPACE or press F2 (Excel's edit command) before typing the abbreviation. 

Microsoft Word 

See the section on “Recommend SpeedType Setting” for the suggesting SpeedType setting for 
Microsoft Word. 
 
Microsoft Word, by default, automatically adds extra spaces if you select the "Simulate 
Clipboard Paste if Text Only" as the SpeedType text transfer method.  
 
To disable the automatic spaces in Word 2010 and later: 

4. In MS Word, click the File tab (found at the top left corner of your MS Word window) and 
then click Options on the bottom of the File Options pane. 

5. On the left pane, select Advanced. 



6. Under the "Cut, copy and paste" section, uncheck the "Use smart cut and paste" box. 
 
 To disable the automatic spaces in Word 2007: 
 

5. Click the Office button (the large round button on the upper left corner) 
6. Click Word Options (at the bottom of the menu). 
7. On the left pane, select Advanced. 
8. Under the "Cut, copy and paste" section, uncheck the “Use smart cut and paste" box. 

 
For older versions of Word: 

3. From Word's Tools menu, click Options then click the Edit tab. 
4. Uncheck the "Smart cut and paste" box. 

 
Also see: Running SpeedType as "administrator". 

Remote Desktop 

This fix requires SpeedType v10.1b or later (choose ABOUT from SpeedType’s HELP menu to 
see what version of SpeedType you have). 
 

1. Press F10 to bring up SpeedType, shut it down (choose EXIT from SpeedType's FILE 
menu). 

2. Choose Preferences from SpeedType's File menu. 
3. Select the "4. AutoReplace" tab. 
4.  Select (check) the following two boxes: 

 
                 Support Different User Context 
              Use non-zero playback scancode 
 
  (The above two boxes should be CHECKED.) 
  

5. Click the HIDE button to make the SpeedType Main Window disappear. 
 

Start/Stop Foot Pedal 

Open Start/Stop. 
At top of window select CONFIGURE. 
Select Hot Keys. 
In the upper right corner SELECT DISABLE HOTKEYS. 
Click OK.  
Reboot the computer. 
 
THE END 


